
 

Global Access 
v1.04 



 

Global_Access_1.04_Users_Manual_1.doc 

- 1 - 

Global Access v1.04 
Ultra-e+ Ethernet Communicator 

 
 
Γενικά 

Το λογισμικό Global Access επιτρέπει τον απομακρυσμένο, ενσύρματο χειρισμό και την τηλεμετρία 
της συσκευής Ultra-e+ μέσω ηλεκτρονικού υπολογιστή (PC). Εγκαθιστώντας το έχετε τη δυνατότητα 
να τροποποιείτε τις παραμέτρους της συσκευής χωρίς να βρίσκεστε εκεί. Μπορείτε επίσης να 
παρακολουθείτε από το χώρο σας τις τιμές λειτουργίας της εγκατάστασης και μάλιστα να κρατάτε 
αρχείο με τις τιμές αυτές. Για τη σύνδεση μεταξύ του Ultra-e+ και του PC απαιτείται καλωδιακή 
σύνδεση Ethernet. 
 

Δυνατότητες 

• Σύνδεση απευθείας σε PC ή μέσω τοπικού δικτύου ή μέσω internet.  

• Ρύθμιση των παραμέτρων λειτουργίας 

• Απεικόνιση και καταγραφή των λειτουργικών μεγεθών 

• Επιλογή των προς απεικόνιση χρήσιμων μεγεθών σε γραφική παράσταση 

• Δυο ανεξάρτητα επίπεδα πρόσβασης (χρήστης, εγκαταστάτης) 

• Κωδικός πρόσβασης για ασφαλή επικοινωνία 
 

Απαιτήσεις 
Για να λειτουργήσει το λογισμικό Global Access πρέπει να εγκατασταθεί σε προσωπικό ηλεκτρονικό 
υπολογιστή (PC) που είναι εφοδιασμένος με λειτουργικό σύστημα Windows. Έχουν δοκιμαστεί και 
λειτουργούν αποτελεσματικά διάφορες εκδόσεις του λειτουργικού Windows.  
Κατά την εκτέλεσή του το λογισμικό δεν έχει ιδιαίτερες απαιτήσεις υπολογιστικής ισχύος. Η 
χρησιμοποίηση ισχυρότερου PC θα κάνει τη λειτουργία του λογισμικού ακόμα πιο άνετη και ομαλή. 
Ο υπολογιστής πρέπει υποχρεωτικά να είναι εφοδιασμένος με κάρτα δικτύου Ethernet Base-T 
10/100. 
Το Ultra-e+ είναι και αυτό εφοδιασμένο με υποδοχή Ethernet. Μπορείτε να συνδέσετε το Ultra-e+ με 
το PC απευθείας ή μέσω κάποιου δικτύου τοπικού Ethernet ακόμα και μέσω του internet.  
 

ΠΡΟΣΟΧΗ Το λογισμικό Global Access εξελίσσεται συνεχώς ώστε να διορθώνονται τα 
πιθανά προβλήματα και να ενσωματώνονται νέες δυνατότητες. Αναζητήστε την πλέον 
ενημερωμένη, Basic έκδοσή του στο www.charmeg.gr. Αν είστε καταχωρημένος χρήστης 

ζητήστε από τη Charmeg να σας στείλει τη Full έκδοση.  
 
Για την αντιστοιχία έκδοσης του Ultra-e+ και του προγράμματος Global Access συμβουλευθείτε τον 
πίνακα στο τέλος του παρόντος οδηγού.      
 

Εγκατάσταση  
Το λογισμικό διατίθεται σε μορφή συμπιεσμένου αρχείου (zip).  
 
Για την εγκατάστασή του κάντε τα εξής. 

1. Απεγκαταστήστε πιθανές παλαιές εκδόσεις του ίδιου λογισμικού. 
2. Αποσυμπιέσετε το αρχείο αυτό σε έναν οποιονδήποτε φάκελο του υπολογιστή σας. 
3. Τρέξτε το αρχείο setup.exe. 
4. Ο υπολογιστής θα σας καθοδηγήσει στα επόμενα βήματα. Δεν έχετε να κάνετε επιλογές κατά τη 

διάρκεια της εγκατάστασης.  Αν ο προκαθορισμένος φάκελος εγκατάστασης δεν σας ικανοποιεί θα 
σας δοθεί η δυνατότητα κατά τη διάρκεια της εγκατάστασης να τον αλλάξετε. 

5. Με την ολοκλήρωση της εγκατάστασης έχει εγκατασταθεί στο μενού του υπολογιστή σας μια νέα 
επιλογή Charmeg> Global Access.  
 

Απεγκατάσταση  
Για να απεγκαταστήσετε το λογισμικό ενεργήστε ως εξής. 

1. Μεταβείτε στο Control Panel (Πίνακα Ελέγχου) των Windows. (Start>Control Panel, Έναρξη>Πίνακας 
Ελέγχου). 

2. Εντοπίστε το εικονίδιο Add Remove Programs (Προσθαφαίρεση Προγραμμάτων) και εκτελέστε το. 

http://www.charmeg.gr/
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3. Στη λίστα που εμφανίζεται εντοπίστε το πρόγραμμα Global Access και πατήστε απεγκατάσταση.  
4. Ακολουθήστε τις οδηγίες του υπολογιστή. 
6. Ποτέ μην προσπαθήσετε να απεγκαταστήσετε το λογισμικό διαγράφοντας τα αρχεία από το φάκελο 

εγκατάστασης. 
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Φυσική σύνδεση 
Για τη φυσική σύνδεση μεταξύ του Ultra-e+ και του PC που εκτελεί το πρόγραμμα Ethernet 
Communicator μπορούν να ακολουθηθούν διάφορες τοπολογίες. Μπορεί να γίνει απ’ ευθείας 
σύνδεση της συσκευής με το PC, σύνδεση μέσω τοπικού δικτύου LAN, και σύνδεση μέσω του 
internet.  
 
Ι. Απευθείας σύνδεση 
Για τη σύνδεση αυτή θα χρησιμοποιήσετε καλώδιο UTP-CAT5 (crossed cable) και θα συνδέσετε 
κατευθείαν το PC σας με το Ultra-e+ μέσω της θύρας Ethernet. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ΙΙ. Μέσω τοπικού δικτύου LAN 
Για τη σύνδεση αυτή θα χρησιμοποιήσετε καλώδιο UTP-CAT5 (patch cable). Θα συνδέσετε το Ultra-
e+ μέσω του καλωδίου αυτού με το Router του τοπικού δικτύου.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
ΙΙΙ. Μέσω του internet 
Για τη σύνδεση αυτή θα χρησιμοποιήσετε καλώδιο UTP- CAT5 (patch cable). Θα συνδέσετε το Ultra-
e+ μέσω του καλωδίου αυτού με το ROUTER του τοπικού δικτύου. Το τοπικό αυτό δίκτυο πρέπει να 
έχει απ’ ευθείας μόνιμη σύνδεση με το internet μέσω γραμμής ΑDSL και καλό είναι να διαθέτει 
στατική IP διεύθυνση. Αν δε διαθέτει στατική IP διεύθυνση αλλά δυναμική τότε για τη σύνδεση 
απαιτείται η γνώση της διεύθυνσης αυτής. 
 
 
 
 

Εικόνα 1 

Εικόνα 2 
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Ρυθμίσεις 
Αρχικά 
Κάθε συσκευή που συνδέεται σε δίκτυο Ethernet διαθέτει απαραίτητα μια διεύθυνση που 
ονομάζεται διεύθυνση IP. Η μορφή της διεύθυνσης αυτής είναι δεδομένη για κάθε υποδίκτυο. Είναι 
υποχρεωτικό κάθε συσκευή που συνδέεται στο δεδομένο υποδίκτυο να έχει διεύθυνση που να 
υπακούει στη μορφή διευθύνσεων του υποδικτύου. Επίσης η κάθε διεύθυνση πρέπει να είναι 
μοναδική. Η συσκευή Ultra-e+ διαθέτει προρυθμισμένη τη διεύθυνση 192.168.0.50.  Μπορείτε να 
αλλάξετε τη διεύθυνση αυτή χρησιμοποιώντας έναν οποιονδήποτε δικτυακό φυλλομετρητή (Firefox, 
Opera, Internet Explorer κ.α.). Για την αλλαγή της διεύθυνσης IP του Ultra-e+ πρέπει πρώτα να 
συνδεθείτε με κάποιον από τους τρόπους Ι ή ΙΙ που αναφέρθηκαν παραπάνω.  
 
Για να το πετύχετε ενημερωθείτε πρώτα τη διεύθυνση IP του PC σας και τη μορφή των διευθύνσεων 
στο τοπικό σας δίκτυο LAN. Πολύ πιθανόν το τοπικό σας δίκτυο να ακολουθεί τη μορφή 
διευθύνσεων 192.168.0.xxx (όπου xxx ένας αριθμός από το 1 έως το 255). Αν συμβαίνει κάτι τέτοιο 
(τότε το Ultra-e+ ανήκει ήδη στο ίδιο υποδίκτυο με το τοπικό σας δίκτυο LAN) μπορείτε να συνδέσετε 
το Ultra-e+ με το τοπικό δίκτυο αμέσως ακολουθώντας τον τρόπο σύνδεσης ΙΙ.  
 
Αν όχι τότε θα πρέπει να αλλάξετε τη διεύθυνση του PC σας ώστε να βρεθεί αυτό στο ίδιο υποδίκτυο 
με το Ultra-e+. Για να το πετύχετε αλλάξτε τη διεύθυνση του PC σε κάποια της μορφής 192.168.0.xxx 
όπου το xxx είναι ένας αριθμός από 1 έως 255, εκτός από το 50 που καταλαμβάνεται από το Ultra-e+. 
Προτείνεται πριν την αλλαγή να σημειώσετε τις παλιές ρυθμίσεις ώστε μετά να μπορείτε να 
επαναφέρετε το PC στην αρχική του κατάσταση. Όταν PC και Ultra-e+ βρεθούν στο ίδιο υποδίκτυο 
μπορείτε να ακολουθήσετε τη σύνδεση Ι ή ΙΙ.  
 
Ανοίγοντας τον φυλλομετρητή και πληκτρολογώντας τη διεύθυνση 192.168.0.50 του Ultra-e+ θα 
εμφανιστεί η πρώτη σελίδα του όπως φαίνεται στην Εινόνα 4.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Εικόνα 4 
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Στην προτροπή για εισαγωγή ονόματος χρήστη και κωδικού πρόσβασης μην εισάγετε τίποτα και 
πατήστε απλώς το OK. Θα εμφανιστεί η Εικόνα 5. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Από την αριστερή στήλη επιλέξτε το Network. Σας ανοίγει η οθόνη της Εικόνας 6. Εντοπίστε και 
αλλάξτε την τιμή του IP Address και του Subnet Mask. Όταν θα εισάγετε την τιμή της IP Address το 
ίδιο το πρόγραμμα θα σας προτείνει και τη σωστή τιμή για το Subnet Mask. 
 
Δεν είναι απαραίτητο να αλλάξετε τίποτε άλλο. Για να ολοκληρώσετε τη διαδικασία πατήστε OK και 
από την αριστερή στήλη Apply Settings. Περιμένετε μέχρι να τελειώσει η μεταφορά των 
πληροφοριών και στη συνέχεια κλείστε το φυλλομετρητή. 
 
 

ΠΡΟΣΟΧΗ Η αλλαγή της διεύθυνσης του Ultra-e+ δεν είναι δύσκολη. Προσέξτε όμως να 
μην μεταβάλλετε κατά λάθος ή από περιέργεια καμία άλλη ρύθμιση διότι είναι δυνατόν 

να χάσετε εντελώς την πρόσβαση σε αυτό. Στην περίπτωση αυτή η συσκευή Ultra-e+ θα πρέπει να 
επιστραφεί για επαναπρογραμματισμό. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Εικόνα 5 

Εικόνα 6 
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Συνδέσεις 
Αφού ολοκληρώσετε την αλλαγή της διεύθυνσης IP του Ultra-e+ ώστε να βρεθεί στο ίδιο υποδίκτυο 
που πρόκειται να λειτουργήσει είστε έτοιμοι για τη σύνδεση. Ανάλογα με ποιον τρόπο από τους Ι, ΙΙ, 
ΙΙΙ έχετε επιλέξει πρέπει να κάνετε τα παρακάτω. 
 
Ι. Απευθείας σύνδεση  
Για την απευθείας σύνδεση δεν απαιτείται καμία επιπλέον ενέργεια. Εκκινήστε το λογισμικό 
Ethernet Communicator. 
 
ΙΙ. Μέσω τοπικού δικτύου LAN  
Για τη σύνδεση μέσω τοπικού δικτύου LAN αποσυνδέστε το UTP-CAT5 (crossed cable) από το PC και 
από το Ultra-e+. Στη συνέχεια συνδέστε το PC με το ROUTER του LAN σας μέσω του 
κανονικού UTP (patch cable). Συνδέστε επίσης το Ultra-e+ με το ROUTER μέσω καλωδίου UTP-CAT5 
(patch cable). Θυμηθείτε να επαναφέρετε τις ρυθμίσεις του PC σας ώστε να βρεθεί στο υποδίκτυο 
του τοπικού σας LAN. Εκκινήστε το λογισμικό Global Access. 
 
ΙΙΙ. Μέσω του internet 
Η σύνδεση μέσω του internet απαιτεί μερικά ακόμα βήματα. Σε μια σύνδεση ADSL το ADSL modem 
έχει μια μοναδική διεύθυνση IP στο Internet. Η διεύθυνση αυτή (στατική ή δυναμική) πρέπει να σας 
είναι γνωστή. Το ADSL modem συνδέεται επίσης με το τοπικό LAN μέσω ενός ROUTER. Πολλές φορές 
το ROUTER αυτό ενσωματώνεται στο ADSL modem. Το τοπικό δίκτυο LAN όπως είπαμε έχει τη δική 
του μορφή διευθύνσεων. Η μορφή αυτή είναι εντελώς ανεξάρτητη από τη διεύθυνση IP που έχει το 
ADSL modem στο internet.  
 
Ας υποθέσουμε τώρα ότι έχουμε μια εγκατάσταση στην οποία θέλουμε να τοποθετήσουμε το Ultra-
e+. Αρχικά πρέπει να μάθουμε τη μορφή των διευθύνσεων του τοπικού δικτύου LAN και να δώσουμε 
στο Ultra-e+ μια μοναδική διεύθυνση που να ανήκει του υποδίκτυο αυτό. Ο τρόπος αλλαγής 
περιγράφηκε παραπάνω.  
 
Απομένει ένα ακόμα στάδιο. Ονομάζεται Port forwarding (προώθηση θύρας) και είναι απαραίτητο 
στην περίπτωση αυτή. Ο λόγος ύπαρξης του σταδίου αυτού είναι προφανής. Όταν παρεμβάλλεται το 
internet μεταξύ PC και Ultra-e+ το λογισμικό Ethernet Communicator καλεί το Ultra-e+ μέσω της 
internet IP διεύθυνσης του ADSL modem. Η κλήση γίνεται αλλά η πληροφορία που φτάνει στο ADSL 
modem πρέπει να ανακατευθυνθεί στο Ultra-e+ που βρίσκεται στο τοπικό LAN. Η διαδικασία Port 
forwarding κάνει ακριβώς αυτό. Λέει δηλαδή στο ADSL modem ότι αν έρθει κλήση από το internet 
που να αφορά το Ultra-e+ τότε να κατευθύνει την κλήση αυτή στην τοπική διεύθυνση που έχει το 
Ultra-e+. Πώς όμως γνωρίζει το ADSL modem ότι η κλήση απευθύνεται στο Ultra-e+ ώστε να τη 
στείλει εκεί; Όταν γίνεται κάποια κλήση το λογισμικό δε χρησιμοποιεί μόνο τη διεύθυνση IP του 
Ultra-e+. Στην πραγματικότητα χρησιμοποιεί και έναν ακόμα λιγότερο γνωστό αριθμό που λέγεται 
Port. To Ultra-e+ χρησιμοποιεί την Port με αριθμό 10001. Και αυτός ο αριθμός μπορεί επίσης να 
αλλάξει αν υπάρχει λόγος. To Port forwarding λοιπόν στηρίζεται στο εξής: δέχεται τις κλήσεις μέσω 
του internet και σε συγκεκριμένη Port και τις ανακατευθύνει σε συγκεκριμένη διεύθυνση του 
τοπικού LAN και στην ίδια Port. Πώς όμως το γνωρίζει αυτό το ADSL modem ώστε να το κάνει; Δεν το 
γνωρίζει. Θα πρέπει να ρυθμιστεί. Όλα τα καλά ADSL modems ακόμα και τα οικονομικά διαθέτουν 
πλέον τη λειτουργία του Port forwarding.  
 
Πρέπει λοιπόν να μπείτε στο menu ρύθμισης του ADSL modem και να ρυθμίσετε το Port forwarding 
ώστε όταν λαμβάνει κλήση στην Port 10001 να την κατευθύνει στην τοπική διεύθυνση του Ultra-e+ 
και στην ίδια Port.  
 
Με την ολοκλήρωση του σταδίου αυτού είστε έτοιμοι για να επικοινωνήσετε με το Ultra-e+ μέσω 
internet. Εκκινήστε το λογισμικό Ethernet Communicator. To PC που εκτελείται το λογισμικό πρέπει 
ασφαλώς να έχει πρόσβαση στο internet. Δεν είναι απαραίτητο η πρόσβαση αυτή να είναι ADSL. 
Αρκεί μια σύνδεση ISDN ή ακόμα και μια απλή Dial-up.  

Επεξηγήσεις 
Γενικά 
Το λογισμικό Global Access διαθέτει δυο διαφορετικές εκδόσεις που συνιστούν δυο επίπεδα 
προσβασιμότητας.  
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1. Την έκδοση Basic με την οποία μπορείτε να διαβάσετε τις τιμές και τις παραμέτρους του Ultra-e+. 
Μπορείτε επίσης να συλλέξετε τις τιμές των μετρήσεων και να τις απεικονίσετε γραφικά ή και να τις 
αποθηκεύσετε σε αρχεία. Δε μπορείτε να μεταβάλλετε τις τιμές αυτές. Η έκδοση Basic προορίζεται 
για τον ενδιαφερόμενο τελικό χρήστη και διατίθεται στο internet.  

2. Την έκδοση Full με την οποία μπορείτε να κάνετε όλα όσα με την έκδοση Basic. Επιπλέον μπορείτε να 
μεταβάλλετε τις τιμές του Ultra-e+. Η μεταβολή των παραμέτρων, ιδιαίτερα όταν γίνεται με τρόπο 
απομακρυσμένο, απαιτεί μεγάλη προσοχή και εμπειρία. Η έκδοση Full απευθύνεται μόνο σε 
εγκαταστάτες και έμπειρους χρήστες. Δε διατίθεται ελεύθερα στο internet και φέρει συγκεκριμένο 
αριθμό καταχώρησης (registration number) που σχετίζεται άμεσα με τον αγοραστή του Ultra-e+.    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Όταν εκκινείται το λογισμικό Ethernet Communicator εμφανίζεται η Εικόνα 7 και αμέσως μετά το 
Κεντρικό Παράθυρο  του Global Access της Εικόνας 8. Από εδώ μπορείτε να κάνετε όλους τους 
βασικούς χειρισμούς. 
 
Κεντρικό Παράθυρο Ultra-e+ Ethernet Communicator 
 
Περιλαμβάνει το πλαίσιο Communication στο οποίο παρουσιάζονται πληροφορίες σχετικές με την 
επικοινωνία.  
 
Tx/Rx Δίπλα ακριβώς υπάρχει ένα πλαίσιο. Εντός του πλαισίου βρίσκονται δυο έγχρωμοι οπτικοί 
ενδείκτες. Ο κίτρινος ανάβει όταν γίνεται αποστολή πληροφοριών και ο πορτοκαλής όταν γίνεται 
λήψη. Είναι πολύ σημαντικό στοιχείο διότι μας δείχνει την δραστηριότητα στη διασύνδεση Ethernet. 
 
IP Address, Port, SIP Address, Retries είναι οι τιμές των αντίστοιχων μεταβλητών επικοινωνίας. Εδώ 
μπορείτε απλά να δείτε τις τιμές των παραμέτρων. Η σημασία και ο τρόπος μεταβολής τους θα 
εξηγηθεί στην ενότητα Parameters πιο κάτω.     
 
Το κουμπί Connect & Login ανοίγει τη σύνδεση Ethernet με το Ultra-e+ και μας επιτρέπει να 
εισάγουμε τον κωδικό ασφαλείας ώστε να μας επιτραπεί η πρόσβαση.  
Δίπλα από το κουμπί βρίσκεται ένας φωτεινός ενδείκτης. Όταν είναι κόκκινος δεν έχει γίνει σύνδεση 
Ethernet. Όταν είναι πράσινος έχει επιτευχθεί σύνδεση Ethernet.  
 
Το κουμπί Logout διακόπτει την πρόσβαση με τον παρόντα κωδικό ασφαλείας στο Ultra-e+ αλλά 
διατηρεί τη σύνδεση Ethernet ανοιχτή. 
 
Δίπλα από το πλήκτρο εμφανίζεται ένας μπλε ενδείκτης όταν έχει επιτευχθεί πρόσβαση με το σωστό 
κωδικό ασφαλείας. 
 
Το κουμπί Disconnect κλείνει τη σύνδεση Ethernet αφού προηγουμένως διακόπτει την πρόσβαση με 
τον παρόντα κωδικό (logout). 
 

Εικόνα 7 Εικόνα 8 
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Το κουμπί Exit τερματίζει τη λειτουργία του προγράμματος. 
 
Μενού File 
Περιλαμβάνει μόνο την επιλογή Exit. Επιλέγοντάς τη κλείνουμε το πρόγραμμα. 
 
Μενού Parameters 
Για να ρυθμίσετε τις παραμέτρους επικοινωνίας από το μενού Parameters>Communication 
ενεργοποιήστε την αντίστοιχη φόρμα. Αμέσως εμφανίζεται η Εικόνα 9. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
Στα πεδία της IP Address εισάγετε την IP του Ultra-e+ αν η σύνδεση που ακολουθείτε είναι τύπου Ι ή 
ΙΙ. Αν έχετε ακολουθήσει σύνδεση τύπου ΙΙΙ τότε εισάγετε την internet διεύθυνση του ADSL modem. 
Το πεδίο Port περιέχει τον αριθμό της Port στην οποία θα γίνει η κλήση. Συνήθως δεν υπάρχει λόγος 
να αλλάξει. Αν παρόλα αυτά χρειαστεί να μεταβληθεί θυμηθείτε ότι πρέπει να εισάγετε την ίδια τιμή 
και στο Ultra-e+.  
 
Υπάρχουν επίσης δυο ακόμα παράμετροι των οποίων την τιμή μπορείτε να μεταβάλλετε. Η SIP 
Address και ο αριθμός Retries. Το SIP προέρχεται από τα αρχικά των λέξεων Serial 
Intercommunication Protocol και αποτελεί πνευματική ιδιοκτησία της εταιρείας Charmeg. Το 
λογισμικό Ethernet Communicator επικοινωνεί με το Ultra-e+ χρησιμοποιώντας το Εthernet αλλά 
στέλνοντας εντολές του πρωτοκόλλου SIP. Στο πρωτόκολλο SIP κάθε συσκευή έχει επίσης μια 
μοναδική διεύθυνση που είναι ένας αριθμός από το 1 έως το 255. Οι συσκευές Ultra-e+ έχουν 
διεύθυνση SIP 5 ή οποία δε μπορεί να μεταβληθεί. Συνεπώς δεν υπάρχει λόγος να αλλάξετε την τιμή 
του πεδίου SIP Address. Αν το κάνετε δε θα μπορείτε να επικοινωνήσετε με το Ultra-e+. 
 
O αριθμός Retries είναι πολύ σημαντικός. Σε περιπτώσεις κατά τις οποίες η επικοινωνία δεν είναι 
καλή ο Ultra-e+ μπορεί να μην λάβει την κλήση ή να την λάβει λάθος. Μπορεί επίσης να τη λάβει 
σωστά αλλά η πληροφορία να μην επιστρέψει σωστά στο PC. Ο αριθμός Retries ρυθμίζει πόσες 
προσπάθειες επανάκλησης πρέπει να γίνουν σε περίπτωση κακής επικοινωνίας. Μια καλή τιμή είναι 
το 5. Σε περιπτώσεις πολύ κακής επικοινωνίας μπορείτε να το αυξήσετε έως το 10. 
 
Το κουμπί Apply ενεργοποιεί τις τιμές της επικοινωνίας. Το κουμπί Exit κλείνει το παράθυρο χωρίς να 
ενεργοποιήσει τις τιμές.  
 
Στη φόρμα Communication Parameters υπάρχει το μενού File. Μέσα στο μενού File βρίσκονται οι 
επιλογές Load και Save As. Με την επιλογή Save As μπορείτε να σώσετε τις ρυθμίσεις της φόρμας 
Communication Parameters σε ένα αρχείο με όνομα της αρέσκειας  σας και κατάληξη .cop. Τις 
ρυθμίσεις αυτές μπορείτε να επαναφέρετε επιλέγοντας το κατάλληλο αρχείο με την επιλογή Load. Η 
λειτουργία αυτή βοηθάει πολύ όταν έχετε να διαχειριστείτε πολλές συσκευές Ultra-e+. Μπορείτε να 
αποθηκεύετε τις ρυθμίσεις επικοινωνίας με το κάθε Ultra-e+ σε αρχείο με διαφορετικό όνομα ώστε 
μετά μα τις ανασύρετε εύκολα χωρίς να χρειάζεται να τις θυμάστε απ’ έξω.  
 
Μενού Tools 
Εδώ θα βρείτε τρεις επιλογές. Η πρώτη Tools>Ultra Configurator σας οδηγεί στη φόρμα ανάγνωσης 
και τροποποίησης των παραμέτρων του Ultra-e+. 
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Η δεύτερη Tools>Ultra Monitor σας οδηγεί στη φόρμα παρακολούθησης των μετρήσεων της 
συσκευής. Σε αυτή τη φόρμα μπορείτε να δείτε τις γραφικές παραστάσεις των θερμοκρασιών και να 
τις αποθηκεύσετε σε αρχεία. 
 
Η τρίτη επιλογή Tools>Advanced δεν είναι διαθέσιμη στις εκδόσεις Basic και Full.  
 
Οι επιλογές του μενού Tools μπορούν να γίνουν μόνο όταν υπάρχει ενεργή σύνδεση μεταξύ του PC 
και του Ultra-e+. Σε οποιαδήποτε άλλη περίπτωση λαμβάνετε μήνυμα λάθους. 
Μενού Help 
Περιέχει την επιλογή About από την οποία μπορείτε να λάβετε μερικές χρήσιμες πληροφορίες της 
έκδοσης του προγράμματος. 
 
Παράθυρο Ultra-e+ Configurator 
 
Μέσα στο παράθυρο Ultra-e+ Configurator (Εικόνα 10) υπάρχουν έξι πλαίσια. Το καθένα τους 
αναφέρεται σε ένα σύνολο παραμέτρων του Ultra-e+. Επίσης το καθένα τους περιέχει τρία κουμπιά. 
Το κουμπί Read διαβάζει τις παραμέτρους που είναι γραμμένες στο Ultra-e+. Το κουμπί Write 
γράφει τις παραμέτρους στο Ultra-e+. Το κουμπί Verify δεν είναι ενεργοποιημένο.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Κάτω από το κάθε σύνολο των τριών κουμπιών υπάρχει ένα πλαίσιο μηνύματος που μας ενημερώνει 
για το αποτέλεσμα της εντολής Write. Όταν εμφανίζει OK σημαίνει ότι η εγγραφή των παραμέτρων 
στο Ultra-e+ έγινε με επιτυχία. Το αντίθετο συμβαίνει όταν εμφανίζει ERROR. 
 
Κάτω αριστερά υπάρχει επίσης ένα παράθυρο στο οποίο εμφανίζεται η γραφική απεικόνιση της 
διαμόρφωσης που έχει επιλεγεί. 
 
Condition Διαβάζει τις θερμοκρασίες των αισθητηρίων και τις απεικονίζει στα σχετικά πλαίσια που 
βρίσκονται από πάνω. Ταυτόχρονα εμφανίζει και τα πιθανά προβλήματα των αισθητηρίων.  
 
Reset Επανεκκινεί τη συσκευή Ultra-e+. Όταν ολοκληρωθεί ο απομακρυσμένος προγραμματισμός 
της συσκευής συνιστάται επανεκκίνηση. 
 
Read all Εκτελεί ανάγνωση όλων των παραμέτρων. Είναι σαν να πατάμε όλα τα πλήκτρα Read. 
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Write all Εκτελεί εγγραφή όλων των παραμέτρων. Είναι σαν να πατάμε όλα τα πλήκτρα Write. 
 
Clear all Καθαρίζει όλα τα πλαίσια.  
 
Exit Κλείνει τη φόρμα Ultra-e+ Configurator 
 
Mενού File 
Load Φορτώνει το αρχείο που περιλαμβάνει τις παραμέτρους του Ultra-e+. 
 
Save As Σώζει τις τιμές σε αρχείο με όνομα που δίνετε εσείς ώστε να μπορείτε να τις ανακαλέσετε 
στη συνέχεια. 
 
Exit Επιλέγοντάς τη κλείνουμε το πρόγραμμα. 
 
Μενού Help 
Περιέχει την επιλογή About από την οποία μπορείτε να λάβετε μερικές χρήσιμες πληροφορίες της 
έκδοσης του προγράμματος. 
 
Παράθυρο Ultra-e+ Monitor 
Στο παράθυρο που φαίνεται στην Εικόνα 11 μπορείτε να δείτε την λειτουργία του Ultra-e+ με 
παραστατικό τρόπο και να κάνετε μελέτη της λειτουργίας του. Μπορείτε να λαμβάνετε συνεχώς 
δεδομένα και να τα απεικονίζετε στην οθόνη. Τα δεδομένα μπορούν να αποθηκεύονται σε αρχείο 
ώστε να γίνει εκ των υστέρων μελέτη. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Το παράθυρο περιλαμβάνει μια κεντρική οθόνη στην οποία γίνεται η γραφική απεικόνιση των 
θερμοκρασιών των αισθητηρίων. 
 
Αριστερά αυτής περιλαμβάνει το πλαίσιο Setup. Από αυτό μπορούν να επιλεγούν ποια αισθητήρια 
θα απεικονίζονται στη γραφική παράσταση. Μπορεί επίσης να επιλεγεί και το αν τα δεδομένα θα 
εγγράφονται σε αρχείο ή όχι. 
 
Υπάρχει επίσης το πλαίσιο Readout. Εδώ μπορείτε να διαβάσετε τις θερμοκρασίες των αισθητηρίων, 
το εάν κάποιο από αυτά παρουσιάζει σφάλμα καθώς και την κατάσταση των τριών ρελέ εξόδου. 
 
Logger Start Το κουμπί αυτό ενεργοποιεί τη συνεχόμενη διαδικασία ανάγνωσης, απεικόνισης και 
αποθήκευσης των μετρήσεων. 
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Logger Stop Το κουμπί αυτό σταματάει τη διαδικασία ανάγνωσης, απεικόνισης και αποθήκευσης των 
μετρήσεων. 
 
Exit Κλείνει το παράθυρο Ultra-e+ Monitor 
 
Στο κάτω μέρος υπάρχει επίσης και μια μπάρα κύλισης μέσω της οποίας ρυθμίζετε κάθε πόσα 
δευτερόλεπτα θα γίνεται ανάγνωση και απεικόνιση των μετρήσεων. Δίπλα της υπάρχει και το 
πλαίσιο που παρουσιάζει την τρέχουσα τιμή. 
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Λειτουργία 
Αφού εγκαταστήσετε το λογισμικό Global Access είστε έτοιμοι για τη λειτουργία του. Υπενθυμίζεται 
ότι πρέπει να έχετε ήδη κάνει τις σχετικές φυσικές συνδέσεις με αντίστοιχα καλώδια καθώς και να 
έχετε επιλέξει μεταξύ των διαθέσιμων τρόπων επικοινωνίας (Ι, ΙΙ ή ΙΙΙ). 
 
Μετά την εκκίνηση του προγράμματος εμφανίζεται για λίγο η εισαγωγική οθόνη στην οποία 
παρουσιάζονται πληροφορίες σχετικές με την έκδοση και την άδεια χρήσης. Ακολουθεί το κεντρικό 
παράθυρο του προγράμματος. 
 
 
 
 
 
 
 
 
 
 
 
 
Κεντρικό παράθυρο Global Access 

i. Από το μενού επιλέξτε Parameters>Communication ώστε να εμφανιστεί η φόρμα εισαγωγής των 
παραμέτρων επικοινωνίας. Δώστε τις σωστές τιμές όπως εξηγήθηκε παραπάνω. Πατήστε Save και 
στη συνέχεια Exit. 

ii. Στο κεντρικό παράθυρο πατήστε Connect & Login. Όταν το πατήσετε το πρόγραμμα προσπαθεί να 
αποκαταστήσει τη σύνδεση με τη συσκευή Ultra-e+. Αν το επιτύχει ο κόκκινος ενδείκτης που 
βρίσκεται δίπλα γίνεται πράσινος. Τότε συνεχίστε στο επόμενο βήμα Αν δεν γίνει πράσινος τότε η 
σύνδεση Ethernet δεν έχει επιτευχθεί και δεν ωφελεί να συνεχίσετε. Πρέπει απαραίτητα να 
αποκατασταθεί η σύνδεση ethernet. 

iii. Αν η σύνδεση ethernet έχει αποκατασταθεί τότε σε λίγο εμφανίζεται το παράθυρο εισαγωγής του 
μυστικού οκταψήφιου κωδικού (Εικόνα 12) που θα σας επιτρέψει να αποκτήσετε πρόσβαση στον 
προγραμματισμό του Ultra-e+. O κωδικός εμφανίζεται σαν τέσσερα διψήφια νούμερα. Η τιμή που 
εμφανίζεται είναι το 00 00 00 00 (όλα μηδενικά). Τον ίδιο κωδικό έχει αρχικά και το Ultra-e+ 
προρυθμισμένο από το εργοστάσιο. Προτείνεται να αλλαχτεί ο κωδικός αυτός με κάποιον δικό σας 
ώστε να μην έχουν άλλοι πρόσβαση στη συσκευή Ultra-e+ με απομακρυσμένο τρόπο. 

iv. Πατήστε Login. Το λογισμικό προσπαθεί να αποκτήσει πρόσβαση στο Ultra-e+. Αν το επιτύχει ένας 
μπλε ενδείκτης εμφανίζεται δίπλα στο πλήκτρο Logout. Αν δεν το επιτύχει (και αυτό μπορεί να γίνει 
για διάφορους λόγους) δεν ωφελεί να συνεχίσετε. Προσπαθήστε να εντοπίσετε την αιτία και 
ξαναπροσπαθήστε.  Αν ο μπλε ενδείκτης εμφανιστεί τότε σημαίνει ότι έχετε συνδεθεί και σας έχει 
επιτραπεί η πρόσβαση οπότε μπορείτε να συνεχίσετε στο επόμενο βήμα. 

v. Αν θέλετε να κάνετε προγραμματισμό του Ultra-e+ ή ανάγνωση των ήδη υπαρχόντων παραμέτρων 
πατήστε Tools>Ultra Configurator. Αν έχετε συνδεθεί και αποκτήσει δικαιώματα πρόσβασης θα 
ανοίξει το παράθυρο Ultra Configurator. 

vi. Αν θέλετε να δείτε τις τιμές και τη λειτουργία του Ultra-e+ πατήστε Tools>Ultra Monitor. Αν 
προηγουμένως είχατε συνδεθεί και είχατε αποκτήσει δικαίωμα πρόσβασης θα ανοίξει το παράθυρο 
Ultra Monitor.    
 

ΠΡΟΣΟΧΗ Από τη στιγμή που θα αποκτήσετε δικαίωμα μεταβολής των παραμέτρων του 
Ultra-e+ έχετε στη διάθεσή σας 60sec για να εκτελέσετε μια οποιαδήποτε εντολή 

επικοινωνίας με τη συσκευή. Για λόγους ασφαλείας η συσκευή διακόπτει το δικαίωμα 
επικοινωνίας όταν παρέλθει το χρονικό αυτό διάστημα χωρίς να εκτελεστεί καμία επικοινωνία. 
Στην περίπτωση αυτή ενδέχεται ο μπλε ενδείκτης να ανάβει. Για να ξαναποκτήσετε δικαίωμα 
πρόσβασης ξαναπατήστε Connect & Login. 
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Παράθυρο Ultra Configutator 
 
Από το μενού του Ultra-e+ Configurator επιλέξτε Load. Στη φόρμα που θα εμφανιστεί επιλέξτε το 
αρχείο ultra_1.set. To αρχείο αυτό περιλαμβάνει ένα τυπικό παράδειγμα τιμών των παραμέτρων του 
Ultra-e+. Το λογισμικό αποθηκεύει τις τιμές πάντα σε αρχεία με κατάληξη .set. Από την επιλογή 
File>Save As  μπορείτε να αποθηκεύσετε τα δικά σας αρχεία με το όνομα που επιθυμείτε. Έτσι 
μπορείτε να έχετε τις τιμές ρύθμισης των εγκαταστάσεων που έχετε κάνει πάντα μαζί σας π.χ. 
ΠΕΛΑΤΗΣ_1.set. 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Πατώντας κάποιο από τα πλήκτρα Read λαμβάνετε τις τιμές του αντίστοιχου πλαισίου.  

 
Πατώντας κάποιο από τα πλήκτρα Write γράφετε τις τιμές του αντίστοιχου πλαισίου στη μνήμη του 
Ultra-e+. Αν η εγγραφή γίνει σωστά στο κάτω μέρος του πλαισίου απεικονίζεται το μήνυμα OK. 
Διαφορετικά λαμβάνετε το μήνυμα ERROR. Στην περίπτωση που λάβετε μήνυμα ERROR επιχειρήστε 
νέα εγγραφή μέχρι να λάβετε OK. Για να είστε σίγουροι ότι οι σωστές τιμές αποθηκεύτηκαν στη 
συσκευή επιβάλλεται να εκτελέσετε ανάγνωση όλων των τιμών μετά την ολοκλήρωση της εγγραφής.   
 
Πατώντας το πλήκτρο Read all κάνετε ανάγνωση όλων των πλαισίων σειριακά. Πατώντας το Write All 
γράφετε σειριακά στη μνήμη του Ultra-e+ τις τιμές που υπάρχουν στα αντίστοιχα πλαίσια. 
 
Με το πλήκτρο Clear all μπορείτε να καθαρίσετε τα πλαίσια ώστε π.χ. να ακολουθήσει μια νέα 
ανάγνωση των τιμών για λόγους επιβεβαίωσης και καλής λήψης.  
 

ΠΡΟΣΟΧΗ Αν διαπιστώσετε ότι η επικοινωνία είναι δυσχερής και οι εντολές Read all και 
Write all καθυστερούν και δεν ολοκληρώνονται με επιτυχία τότε επιχειρήστε να 

διαβάσετε ή να γράψετε τις τιμές των πλαισίων χρησιμοποιώντας τις μεμονωμένες εντολές Read 
και Write. 
 
 
 

ΠΡΟΣΟΧΗ απαιτείται στην περίπτωση που εκτελείτε Write ή και Write all. Οι τιμές που 
πρόκειται να εγγραφούν πρέπει να έχουν ελεγχθεί σχολαστικά. Διαφορετικά είναι 
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δυνατόν η συσκευή να μη λειτουργεί κανονικά. Ενημερωθείτε για τη σημασία της κάθε 
παραμέτρου και εισάγετε τις τιμές με μεγάλη επιμέλεια. Λανθασμένες τιμές είναι δυνατόν να 
βλάψουν τη εγκατάσταση και να προξενήσουν σοβαρές δυσλειτουργίες. 
  
Το πλήκτρο Condition διαβάζει τις παρούσες τιμές θερμοκρασιών των αισθητηρίων και τα πιθανά 
προβλήματα. Η ανάγνωση γίνεται μία φορά. Για να δείτε τις νέες τιμές ξαναπατήστε το ίδιο πλήκτρο. 
 
Με το πλήκτρο Reset γίνεται επανεκκίνηση της συσκευής. Επανεκκίνηση προτείνεται στην 
περίπτωση εκτεταμένων αλλαγών στις παραμέτρους του Ultra-e+. Η επανεκκίνηση από την πλευρά 
του Ultra-e+ απαιτεί χρόνο μερικών δευτερολέπτων. Επίσης με την επανεκκίνηση το λογισμικό 
Global Access χάνει τη σύνδεση και το δικαίωμα πρόσβασης. Γι αυτό θα πρέπει να ξαναπατήσετε το 
Connect and Login.  
 
Παράθυρο Ultra Monitor 
Από το παράθυρο αυτό μπορείτε να παρακολουθείτε τη λειτουργία του Ultra-e+, την εξέλιξη των 
θερμοκρασιών, τις λειτουργικές παραμέτρους και τα ρελέ που είναι ενεργοποιημένα. Μπορείτε 
επίσης να καταγράφετε τις θερμοκρασίες και τους κωδικούς προβλημάτων σε αρχείο για περαιτέρω 
επεξεργασία και εξαγωγή συμπερασμάτων.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Πατήστε το πλήκτρο Logger Start για να ξεκινήσει η διαδικασία ανάγνωσης και απεικόνισης. Για να 
σταματήσει πατήστε το πλήκτρο Logger Stop. 
 
Όπως προαναφέρθηκε η συσκευή Ultra-e+ αν παρέλθει χρονικό διάστημα μεγαλύτερο των 60sec 
δίχως να λάβει καμία σωστή κλήση διακόπτει το δικαίωμα πρόσβασης προς το πρόγραμμα που την 
έχει καλέσει. Όταν έχετε πατήσει το πλήκτρο Logger Start  το πρόγραμμα στέλνει στο Ultra-e+ 
εντολές ανάγνωσης κάθε 1sec. Επομένως τέτοιος κίνδυνος δεν υπάρχει. Αν όμως δεν έχει 
ενεργοποιηθεί το Logger Start τότε το δικαίωμα της πρόσβασης θα διακοπεί. 
 
Στο πλαίσιο που βρίσκεται αριστερά μπορείτε να επιλέξετε αν τα δεδομένα θα καταχωρούνται ή όχι 
σε αρχείο. Αυτό γίνεται με την επιλογή File logging. Το αρχείο που δημιουργείται λέγεται 
ultradata.txt και το όνομά του δε μπορεί να μεταβληθεί. Αν το σβήσετε το λογισμικό Global Access 
θα δημιουργήσει νέο με το ίδιο όνομα. Τα νέα δεδομένα γράφονται στο τέλος του αρχείου. 
 
Μπορείτε να δείτε τα περιεχόμενα του αρχείου αυτού ανοίγοντάς το με έναν απλό text editor όπως 
το Σημειωματάριο (Notepad) των Windows. Κάθε γραμμή αντιστοιχεί με μια επιτυχημένη μέτρηση. 
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Οι ανεπιτυχείς μετρήσεις δε γράφονται στο αρχείο. Κάθε γραμμή ξεκινάει με την ημερομηνία και την 
ώρα που λήφθηκε η μέτρηση. Ακολουθούν οι θερμοκρασίες των τεσσάρων αισθητηρίων και μετά η 
κατάσταση καθ’ ενός από τα αισθητήρια. Ο κωδικός 0 σημαίνει ότι δεν υπάρχει πρόβλημα. Κωδικός 
1 σημαίνει ότι υπάρχει πρόβλημα στο αντίστοιχο αισθητήριο. Στο τέλος της κάθε γραμμής υπάρχει 
καταχωρημένη η κατάσταση των τριών ρελέ εξόδου του Ultra-e+. 
 
Από το ίδιο πλαίσιο μπορείτε να επιλέξετε τα αισθητήρια η θερμοκρασία των οποίων θα εμφανίζεται 
στη γραφική παράσταση. Υπάρχει χρωματικός κώδικας ώστε να διακρίνεται η θερμοκρασία του κάθε 
αισθητηρίου. Η επιλογή της απεικόνισης αφορά μόνο τη γραφική παράσταση. Στο αρχείο γράφονται 
πάντα οι θερμοκρασίες όλων των αισθητηρίων και όλοι οι κωδικοί των προβλημάτων.  
 
Στο πλαίσιο Readout μπορείτε να δείτε τις θερμοκρασίες των αισθητηρίων, τα πιθανά προβλήματα 
σε κάποιο ή κάποια από αυτά καθώς και την κατάσταση των ρελέ εξόδου.  
 
Από την κυλιόμενη μπάρα που βρίσκεται στο κάτω μέρος της φόρμας μπορείτε να επιλέξετε κάθε 
πότε θα ανανεώνονται τα δεδομένα της γραφικής παράστασης και θα καταχωρούνται τα νέα στο 
αρχείο ultradata.txt. Ο αριθμός αντιστοιχεί σε σωστές αναγνώσεις που εκτελούνται κάθε 1 sec. 
Επομένως αν υπάρχει καλή επικοινωνία και όλες οι προσπάθειες ανάγνωσης είναι επιτυχείς τότε η 
παράσταση ανανεώνεται κάθε τόσα δευτερόλεπτα όσα λέει η τιμή interval. Αν η επικοινωνία δεν 
είναι καλή πολλές από τις αναγνώσεις που γίνονται κάθε 1sec θα είναι ανεπιτυχείς. Επομένως η 
ανανέωση της παράστασης και η εγγραφή στο αρχείο θα γίνεται σε χρονικό διάστημα μεγαλύτερο 
του interval σε δευτερόλεπτα.  
 
Η τιμή του Interval μπορεί να μεταβληθεί από 1sec έως 3600sec που αντιστοιχεί σε 1 ώρα.  
 
Λόγω των πιθανών ανεπιτυχών επικοινωνιών είναι πιθανό ο οριζόντιος άξονας να μην αντιστοιχεί 
στον απόλυτο χρόνο. Ο κατακόρυφος άξονας δεν επηρεάζεται. 

     
ΠΡΟΣΟΧΗ Μπορείτε να έχετε ανοιγμένα τα παράθυρα Ultra Configurator και Ultra 
Monitor ταυτόχρονα ώστε να βλέπετε τις παραμέτρους προγραμματισμού και τη γραφική 

παράσταση. Είναι παρακινδυνευμένο όμως να στέλνετε εντολές και από τα δυο παράθυρα 
ταυτόχρονα. Γι αυτό διακόψτε την εκτέλεση του Logger όταν εκτελείτε οποιαδήποτε εντολή από το 
παράθυρο Ultra Configurator. Παρομοίως όταν εκτελείτε εντολή του Ultra Configurator είναι 
παρακινδυνευμένο να εκκινήσετε το Logger.   
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Εκδόσεις Προγραμμάτων 

 
Υποστήριξη Πελατών 

Charmeg  
www.charmeg.gr 
Ατταλείας 145 - Νίκαια- Αθήνα- Ελλάδα 
 
Τηλ: +30 210 5693111 
Φαξ: +30 210 5693093 
e-mail: info@charmeg.gr 
Skype: Charmeg Live Assistance Europe 
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